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Understanding LogView
LogView provides for easy setup and operation of LogBook.  LogView’s flexibility can handle virtually any
data-acquisition environment.  The graphical Windows interface can display a variety of spreadsheets,
dialog boxes, graphs, charts, and meters; and accepts user input from a mouse and keyboard.
The easy-to-learn interface does not require programming or the configuration block diagrams.

It is important to understand the central role of the PC-Card in LogBook/LogView operation.  When
LogBook operates in a stand-alone mode (not attached to the PC), LogView must download the system and
acquisition setup files to a PC-Card.  The PC-Card must then be manually transferred to LogBook.  Later
LogBook’s PC-Card must be transferred back to the PC for uploading.  When LogBook and PC are
attached in direct communication, LogView can download to [or upload from] LogBook in real time via the
communications link.



pg.  2 05-07-02 LogView

Modes of LogView Operation
The next figure outlines LogView’s functional modes to help you visualize what LogView can do.  This
functional organization is not the same as the menu organization.

Setup

System Setup includes the hardware, the channels in the scan, and the triggering.  Before data acquisition
can begin, all setups must be complete and the resulting setup file downloaded to the PC-Card in LogBook.

• Hardware Configuration asks you to set the software parameters to match your hardware.  For some
DBKs, you may need to adjust the DBK’s jumpers and DIP switches—or at least verify that the
LogView software setting matches the DBK hardware setting (pg. 30).

• Channel Setup pertains to using LogView to set the different types of channel parameters.  These
include label. On/off, range, units, format, user scaling, storage rates, and DBK software parameters.
The types of channels that are set up through LogView are: Analog Input (pg. 31), Digital Input
(pg.35), Output Channels (pg.36), GPS/Serial Input (pg.37), and Calculated Channels (pg.37).  The
flexibility of the Calculated Channel allows you to create a virtual channel based on math and logic
functions of real channels (analog and digital), other virtual channels, and arbitrary numerical values.

• Acquisition Configuration asks you to determine when, how often, and for how long to get data
readings.  Trigger/pre-trigger/post-trigger conditions and timebases are discussed on page pg.43.

• System Calibration allows you to perform 1- or 2-pt calibrations to fine-tune system accuracy.

Monitor

• Monitor Acquisition.  In real-time, LogView can display system parameters and channel values in a
spreadsheet style.  If so desired, readings can be formatted into bargraphs, analog meters, and digital
indicators (pg.55).

• LogBook Monitor  shows you the status of the current acquisition and the LogBook system (pg.49).
• Programmed Digital Outputs Used As Alarms.  The monitoring function can be automated via

calculated channels and digital outputs to engage alarms when pre-defined conditions occur.
• Display Recorded Data. allows you to graphically view previously recorded data for analysis and

comparison via a post-acquisition “view” program.  The applicable “view” application is covered by
PDF documentation that is automatically installed onto your PC’s hard-drive as a part of LogBook
product support, during software installation.
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System Management

LogView allows you to manage aspects of an acquisition in progress and file saving/conversion:
• Direct Acquisition Controls of LogBook include manual triggering and setting reference marks (via

LogBook Monitor, pg.49) and starting/stopping an acquisition.  In these ways, LogView gives you
immediate access to LogBook operation.

• File Management includes managing data/configuration files and converting data file formats.  The
LogView Explorer window allows you to manage files on the PC-Card.

Communication

Communication between LogView and LogBook is actually between the PC and a PC-Card.  During the
communication, the PC-Card can reside in a LogBook for direct (attached) communication or in the PC’s
PC-Card socket for indirect (unattached) communication (and later manually transferred to LogBook).

Whether direct or indirect, communication involves downloading and uploading:

• Downloading sends the acquisition setup file (created in LogView’s Setup mode) to LogBook’s
PC-Card.  LogBook uses the setup file to run the acquisition (also needs logbook.sys).

• Uploading receives recorded data from LogBook’s PC-Card.  After the data has been collected and
temporarily saved on LogBook’s PC-Card, the data must be uploaded to LogView for processing,
conversion, use in other programs, and/or archival saving.

In the Direct (Attached) Communication mode, communication occurs through the electronic connection
(cabling via serial or parallel port).  While attached, LogBook can do 2-point calibration, look at current
readings, and download/upload without handling the PC-Card.

Note:   In some cases, data transfer may be faster by placing LogBook’s PC-Card in the computer’s
PC-Card socket and bypassing the attached communication.

In the Indirect (Unattached) Communication mode, no electrical connection exists between the PC and
LogBook.  A PC-Card carrying the setup file and/or data must be physically transported between the PC
and LogBook.

Note: The LBK1 remote operation terminal can be used with an unattached LogBook for limited control
and monitoring.  The LBK1 option is detailed in chapter 5 of the LogBook User’s Manual.
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LogView Features and Capabilities
In setting up an acquisition, LogView can:

• Configure parameters for all input, output, and calculated channels without using special programming
skills.

• Provide flexible triggering to acquire continuous data, capture exceptions or, to trigger based on
calculated channels.

• Configure and operate expansion chassis, including the DBK option cards and modules designed for
various signal-conditioning environments.

• Provide utilities (convert units, calibrate sensors, calculate channels, control outputs/alarms, etc).

In handling data, LogView can:
• Download an acquisition setup file to a PC-Card for physical transport to a remote LogBook, or send

the setup file directly to the PC-Card in a LogBook via the serial or parallel port.
• Upload the recorded data from LogBook by corresponding means.
• Create files for use by other Windows programs; e.g., database or analysis.

Utility-wise, LogView can:
• Calibrate all gains and offsets on a per-channel basis.
• Launch a separate “view” program that allows you to graphically view pre-recorded data.
• Interact with LogBook while the acquisition is taking place including manual trigger and event

marking.

In monitoring an acquisition, LogView can:
• Display readings and status in real-time.  On-screen indicators provide channel feedback during an

acquisition.  Channel values can be displayed in charts, bar graphs, analog meters, or digital readouts.
• Show system status including trigger status, errors, alarms, etc.
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Software User-Interface
LogView’s user-interface uses a control window with toolbar/menus and a spreadsheet model.  Similar to
other Windows-based programs, LogView’s user interface will seem familiar and intuitive.  Windows can be
sized and placed to best fit your application.  Several different meter styles are available to monitor data in
real time if so desired.

Control Window (Pull-Down Menus and Toolbars)

File View Device Tools Indicators

New Hardware Configuration Select PC Card Convert Binary Data Bar Graph Meters

Open Analog Input Channels Select LogBook Merge Binary Data Analog Meters

Save Digital Input Channels Attach View Data Digital Meters

Save As Output Channels Break Enable Input Reading
Column

Download GPS/Serial Input Channels Arm Acquisition Start All Indicators

Upload Calculated Channels Stop Acquisition Stop All Indicators

Download As Acquisition Configuration LogBook Monitor

Configuration Report Preferences Explorer

About LogView

Authorization

Exit

LogView Pull-down Menu Selections

LogView pull-down menus, represented by the above table are discussed in the section, Menu Descriptions.
The following figure shows LogView’s control window.  Note that two sets of toolbar buttons reside just
below the menu row.
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Toolbar commands can be accessed in two ways: (1) via toolbar, or (2) via pull-down menu selection.  Note that the
pull-down menus include additional commands that do not have associated toolbar buttons.

LogView Control Window – LogBook Unattached

LogView Control Window – LogBook Attached

Legend

1 – New Setup File

2 – Open Setup File

3 – Save Setup File

4 – Break PC from LogBook (Shows when PC is attached), or
   – Attach PC to LogBook (Shows when PC is unattached)

5 – DownLoad to LogBook (Shows when PC is attached), or
   – DownLoad to PC-Card (Shows when PC is unattached)

6 – UpLoad Acquisition Setup & Data to LogBook
             (Shows when PC is attached), or

– UpLoad Acquisition Setup & Data to PC-Card
           (Shows when PC is unattached)

7 – Arm (Start) Acquisition

  8 – Stop Acquisition

  9 – Hardware Configuration

10 – Analog Input Setup

11 – Digital Input Setup

12 – Output I/O Setup

13 – GPS (Global Positioning System) / Serial IN Setup Option

14 – Calculated IN Channel Setup

15 –  Acquisition Configuration

16 –  View Data [via a post acquisition view application]

Spreadsheet Model

LogView’s interface uses a spreadsheet model of cells in rows and columns (see next figure):
• Each row is a different channel.  Individually-controlled channels can be hardware-based or

calculated; channels can be identified with user-specified labels.
• Each column is a parameter related to the channel.  Some parameters can be user-set (user label,

sample rate, etc.); others are read only (physical channel, readings from transducers, etc.).

Note: Generally, cells that are “grayed-out” rather than black are not subject to user input (e.g. physical
channel, channel type); however, grayed-out Sample Rates under the Storage tab can be changed in
the Acquisition Configuration Window.
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Analog Input Channel Configuration Window, Spreadsheet Portion

LogView’s spreadsheet-style setup provides a simple method of both viewing and configuring the
parameters of the input, output, and calculated channels.  Several spreadsheets are needed to display all the
channels’ parameters.  LogView’s spreadsheet windows include:

• Analog Input Channel Configuration (see page pg.31 for details) - This default-opening window
has more parameter columns than will fit in view at one time.  Therefore, the left-most (white)
columns are shown in every view; these parameters include: Physical Channel, User Label, On/Off,
Reading, Range, Units, and Channel Type.  The right-most (shaded) columns vary depending on
which folder tab is selected.  Each tab (Storage, DBK Parameters, User Scaling, and 2-Point
Calibration) has
tab-specific parameters.

• Digital and Counter Input Channel Configuration (see page pg.35) - LogBook has three 8-bit
digital ports and one high-speed 16-bit port configurable as inputs or outputs.  Digital expansion cards
can provide up to 192 digital bits.  There are also 4 pulse-input ports that can count pulses for
summing and/or frequency measurement.

• Output-Channels Configuration (see page pg.36) - This window shows all the currently-available
digital and analog output channels.  Each output channel is fed by a user-set source channel.  Source
channels can be chosen from any of the input (hardware) channels or calculated (virtual) channels.

• Calculated-Channel Configuration (see page pg.37) - LogView can derive virtual channels using
standard math operators and functions (<, >, min, max., etc.).  Virtual channels can be used to create
alarms, reduce data statistically, develop sophisticated trigger equations, and manipulate input channel
values for more useful output including simple control systems.

Help Box
The bottom of the spreadsheet contains a context sensitive Help Box for the selected field.  As you
configure channel parameters, the Help box identifies the field and provides pertinent user information.  An
example, taken from the previous figure, follows.

Example:   In the above figure the User Label cell (of channel 1) is selected.  The Help box identifies the
field as “User-specified channel label” and states user options.  In this case, they are (1) to type
in a desired label, i.e., to provide the channel with more meaningful name [not to exceed 16
characters]; or (2) keep the default label of P1_CH00.

User Input
To set up channel parameters, first select the appropriate cell (highlighted in a bold box) with the mouse or
keyboard arrow keys (up/down/sideways).  Some cells allow you to key-in values from a keyboard (values
such as user labels, offsets, etc.).  When key-in cells are selected, a user-input box will appear where you
can type in characters as needed (e.g., channel label in previous figure).  Some cells allow you to choose the
desired setting from a drop-down list; you select among the options, and the parameter is set.  Other cells
allow you to set numeric values with “spinner” up/down arrows that change the value incrementally
(selecting a point between the spinners changes the mouse action into a virtual scroll bar—as you drag the
mouse vertically, the numeric values change accordingly).
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User-set parameters can be set individually per channel, or the same value can be “filled down” for an entire
column.  To apply the same column setting to multiple channels, use the spreadsheet’s fill-down feature.
Select multiple cells in a column by dragging the mouse with the left mouse button (or using the <Shift>
and arrow keys).  Enable the fill-down feature with the right mouse button.

As a shortcut to toggle channel readings on or off, you can place the cursor in the Reading column and
double-click the mouse.  Another alternative is to double-click the column title, and every channel value in
the column will change to the next value if such a value is list-selectable.  Globally, you can switch all
channel readings in the Indicators menu as Start All Indicators and Stop All Indicators.

For program windows that exhibit an “Apply” button, note that parameter changes will
not be locked-in until the Apply button has been pressed (clicked).

File Management
LogView uses various types of files for its operation:

• System.  logbook.sys is the file that actually operates LogBook.  The file must reside on the PC-Card in
LogBook in order for the system to power-on and work properly.  All PC-Cards used with LogBook need to have
the logbook.sys file.

• Setup (Acquisition Configuration).  The filename extension for the acquisition setup file is .LVC (from
LogView Configuration).  This file is downloaded to LogBook’s PC-Card.  The file contains parameter details for
a particular acquisition (as configured in LogView).  When swapping PC-Cards in a remote LogBook, the new
PC-Card should have the same .LVC file.

• Data.  Names for the data files use a long format convention as described below.  The Preferences window from
the View pull-down menu allows you to customize how your data files will be named.

File Organization

As data is uploaded to the PC, LogView first uploads the raw data file(s)
and then converts them into the formats specified in the Preferences
window.  The raw binary files are placed in the DATA directory in the
path specified during a configuration save.  If the configuration was
never saved the DATA directory will be created in the LogView working
directory.

LogView creates a sub-directory within DATA for each file format
selected.  The figure to the right represents a typical file structure.
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Data Filename Generation

Uploading can create one data file or many data files.  A simple, completed data collection with one
timebase will produce only one data file.  More complex conditions will create multiple data files.  When
these conditions exist, LogView creates a file-set rather than a single file.

These configurations will create multiple data files during an upload.
• With multiple timebases enabled, LogView generates a separate file for each rate.
• With Auto Re-arm set greater than 0, multiple trigger blocks will be collected—each in a separate file.

These events will generate multiple file-sets.
• When LogBook configuration is re-armed through LogView or by cycling LogBook’s power, a new

file-set is created.
• When a partial upload takes place with an attached LogBook, a new file-set is created.
• When a partial upload takes place from a PC-Card in the PC’s socket, a new file-set is created.

A partial upload saves part of the data from an active acquisition.  Three ways to perform a partial upload:
a) During an acquisition, connect your PC to LogBook and execute an upload.  To make room for

additional data, the uploaded data is deleted from the PC-Card.
b) During an acquisition, swap the PC-Card in LogBook with a different card.  Then insert the card into

your PC, and perform an upload.
c) Start an upload of any kind; then click Cancel while the upload is taking place.

Naming Format for Data Files

LogView names uploaded data files to make them easy to identify and organize.  The File Converter
Preferences window (Represented below) allows you to customize LogView’s naming process to suit your
needs.  Navigate as follows to access the window: View Pull-down menu ⇒ Preferences ⇒ File Converter.
Preferences can be set so:

• Files will not be accidentally overwritten
• The use of several LogBooks is easy to manage.
• Test times and dates automatically embedded
• It is easy to identify files that are part of the same acquisition

The figure and table below define the full-field format for data files.  As described in the next section, you
may wish to turn off unneeded fields for simplicity.

seed User-supplied identifier string (e.g., TOM1) provides easy identification of files associated with
a specific test, person, or device-under-test.

#zzzzzz When multiple LogBooks are being used, the 6-digit serial number identifies which LogBook was used
to collect the data.

Ddd-mm-yy The Date field represents the date the acquisition was initially armed.  This date is not necessarily the
date when the data was actually collected.  It is possible LogBook was armed on Thursday but did
not trigger until Saturday.  The file-last-modified date shown as a file attribute in Windows Explorer
(not LogView Explorer) is the date the file was uploaded to the PC.

Thh-mm-ss The Time field represents the time the acquisition was initially armed.  This time is not necessarily the
time when the data was actually collected.  It is possible LogBook was armed at noon but did not
trigger until 2:00pm.  The file-last-modified time shown as a file attribute in Windows Explorer
(not LogView Explorer) is the date the file was uploaded to the PC.

Rx The Rate field holds a number from 1 to 4 representing the scan rate for the file.  If channels are stored
at more than one rate, a file is created for each rate.

Bx-y The Block field holds 2 numbers: x is the trigger block number, and y is the segment of the trigger
block.  A trigger block is segmented when partial uploads take place.  Typically, y will be 1 when the
entire trigger block is uploaded at once.  The numbers are generated chronologically as they occur.

.ext The filename extension for the data files and their explanatory header files (see following figure)
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File Converter Preferences Window
This window is reached by navigating as follows: View Pull-down menu ⇒ Preferences ⇒ File Converter

Customizing the File Name

LogView Preferences Window, Upload Tab Selected
This window is reached by navigating as follows:
View Pull-down menu ⇒ Preferences ⇒ Upload Tab

Under certain conditions, all filename fields may not be needed.  To turn off fields, simply enable or
disable the check boxes in the Upload tab of the Preferences window (see figure here and discussion
 on page pg.46).  Be aware that simplifying the filename removes the safeguards to prevent 2 files having
the same name and causing an overwrite/lost information condition.  If fields are disabled, overwrites are
more likely to occur.

The following table suggests when it is safe to turn off various filename fields.

Condition Recommendation
I want to overwrite old data every time I perform an upload. No optional fields are required.
I only have one LogBook. Turn off LogBook serial number field.
I use a new seed every time I upload. Only the seed option is needed.
I often accumulate multiple acquisitions on the PC-Card and
want to upload them at one time.

Make sure at least the time field is enabled; otherwise,
acquisitions will be overwritten as they are uploaded.

I never perform partial uploads. Don’t need block number.
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Example of all parameters: LAB1 #123456 D03-15-98 T12-04-12 R1 B1-1

SEED (user description string) = “LAB1”

LogBook serial number = 123456

Date armed = March 15, 1998

Time armed = 12:04:12PM

Rate = 1

Trigger block = 1, Segment = 1

Simplest application.  If a new acquisition is uploaded, this file will be overwritten: R1 B1-1

Rate = 1

Trigger block = 1, Segment = 1

If all acquisitions are performed in the same day, the time can identify the files: T12-04-12 R1 B1-1

Time = 12:04:12pm

Rate = 1

Trigger block = 1, Segment = 1

The example below shows data files from an acquisition with 2 trigger blocks and 2 timebases; the
acquisition was uploaded in segments.  All the dates and times are the same because these trigger blocks are
all part of the same acquisition.  The first two files represent a continuous data collection—2 files exist
because of partial uploads.

Example of Data Uploaded in Segments
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Procedures
Because of LogView’s flexibility, this manual can not detail every possible use of the system.  Instead, these
procedures explain how to perform typical tasks.  Understanding these tasks will help you apply the
principles to a variety of data acquisition environments.  For your particular application, you may need
to combine or alter these procedures.  For more details, you may need to refer to related Menu Descriptions
or procedures.

This section begins with a flowchart of a simple acquisition and then explains the following tasks and
operational modes:

Using an Attached LogBook……pg. 13
Using LogBook “Unattached”……pg. 15
Simple Data Logging……pg. 15
Setting Up DBK Cards……pg. 17
Using Multiple Timebases……pg. 18
Using Digital 2-Point Calibration……pg. 19
Using Digital Outputs As Alarms…pg. 22
Using Exception Capturing……pg. 24
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Flowchart of a Simple Acquisition
Consider the flowchart of a simple data acquisition.  Whether LogBook is attached or unattached, the
process is similar except for downloading and uploading.  You begin the process in LogView by defining
the parameters for an acquisition.

Using an Attached LogBook
When using an attached LogBook, LogView communicates directly to the PC-Card in LogBook through the
communication interface (serial or parallel).

After LogView recognizes the attached LogBook, an acquisition setup file can be downloaded to LogBook.
After the acquisition, data can be uploaded from LogBook without handling the PC-Card.
Note that steps 1 through 4 are often done during the initial installation.
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1. On your PC with LogView already loaded, open control panel applet, and check Hardware
Configuration.  If no LogBook is present in the tree, click Add Device and a LogBook ID; otherwise,
select a LogBook in the tree and click Properties.

2. Under LogBook Properties tab, enter or
verify device name, the connection type,
the protocol, a timeout duration; and
then click Apply.

3. (if serial connection) Under Port Settings
tab, select baud rate and related
parameters; and then click Apply.

4. Verify proper LogBook connection and
power-on; then, under the Test Hardware
tab after, click the Test button.  Testing
will verify system parameters and then
bench-mark system communication
performance.

5. Launch LogView from your PC (unless you set up a shortcut, you can find LogView in the Programs
group in the Start menu).  The control window and the Analog Input Channel Configuration window
should appear.

6. Under the Device menu in the control window, click Select LogBook.  From the drop down list,
select LogBook you just configured in the hardware tree; then click the Attach icon to establish
 a communications link.  The Upload and DownLoad buttons in the Control Window should now be
enabled (LogView recognizes when LogBook is attached and enables the applicable tools as seen by
their lettering turning from gray to black).

                    
7. In LogView’s Analog Input Channel Configuration (see page pg. 31) and Acquisition Configuration

(see page pg. 43) windows, set up the channels and trigger parameters you wish to use
(see Simple Data Logging, page pg. 15).

8. Download the acquisition setup file just configured to LogBook
9. Click the Arm Acquisition button ( ).  LogBook is now armed and ready to collect data when the

trigger parameter is satisfied.
10. During the acquisition, you can monitor system status via LogBook Monitor window accessed from

the Device pull-down menu.  To verify proper operation, such monitoring is recommended for the
first run of a new acquisition setup file.

11. After collecting data, click Upload to pull the data into the PC (see page pg. 26).  Depending on the
communication channel and size of data files, uploads take a variable amount of time.  Uploads can
also be done incrementally during an acquisition.

The next time you launch LogView, it will automatically look for the selected LogBook and attempt to
attach itself.  At this point, LogView and LogBook will be in constant communication.  If you want to turn
off LogBook’s power or detach the communication cable, you should first select Break from the Device
menu or Exit from the File menu.

PC-Cards purchased with LogBook have been initialized at the factory.  PC-Cards
purchased elsewhere must be initialized through LogView.  The initialization procedure is
discussed in the following paragraph.

Initializing a PC-Card
PC-Cards, that were purchased with LogBook, have been initialized.  PC-Cards purchased elsewhere
must be initialized.  Initialization is accomplished as follows:

1. Place the PC-Card in the PC’s corresponding socket.

2. Select the driver according to your card’s documentation.

3. In LogView, under the Device menu, click Select PC-Card, then click OK.

LogView will check the card and initialize it as needed.
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Using LogBook “Unattached”

When using a LogBook “unattached,” LogView
does not communicate in real time with
LogBook; instead, LogView downloads the
acquisition setup file to a local PC-Card that can
later be manually transferred to LogBook.

After the acquisition is complete, the PC-Card
that collected data in LogBook must be
manually transferred to the PC where LogView can then upload the data.  The PC-Card must first be
properly initialized :

1. Take any ATA PC-Card memory device, and insert it into a corresponding socket on the PC.  If this
is the 1st time this type of card has been inserted, Windows may require driver information.  Follow
the on-screen instructions, or refer to the documentation included with the PC-Card.

2. Launch LogView from your PC (unless you set up a shortcut, you can find LogView in the Programs
group in the Start menu).  The control window and the Analog Input Channel Configuration window
should appear.

3. Under the Device menu, click Select PC-Card.  Use the drop down list to tell LogView which drive
letter is associated with the PC-Card.  Note: as PC-Cards are inserted
and removed from the sockets, Windows will arbitrarily assign drive
letters.  If 2 PC-Cards occupy 2 sockets, the order of their insertion
usually dictates the assignment of drive letters.  The Attach, Upload,
and Download buttons on the Control Window should now be enabled.

4. In LogView’s Analog Input Channel Configuration and Acquisition Configuration windows, set up
the channels and trigger parameters you wish to use (see Simple Data Logging below).

5. Download the acquisition setup file (logbook.sys will also be downloaded if not already present).
6. Eject (remove) the PC-Card from the PC socket, and transport it to the remote LogBook site.  Insert

the PC-Card into LogBook's socket, and power up LogBook.  LogBook will automatically load the
setup file and arm the system.

7. After the remote LogBook has collected all the data, remove the PC-Card from LogBook's socket,
transport it to the PC, and insert it into the PC's socket.  If LogView is running, it will soon recognize
the presence of the card and enable the Upload and Download buttons.

8. Click Upload to pull the data into the PC.

After telling LogView which drive letters are associated with PC-Card disks, LogView will periodically poll
the system for their presence.  As cards are inserted and ejected, LogView will automatically enable and
disable the Upload and Download buttons.

If a large quantity of data will be recorded, you should return to the remote LogBook
in time to swap PC-Cards [before the first card is full].  Card swapping is discussed in the
introduction chapter of the user’s manual.  All PC-Cards to be swapped must first be
initialized as discussed in the previous section.

Simple Data Logging
To log data, you need to configure the hardware, set up the channels, and configure the acquisition
parameters.  The following steps are generic and will vary with different applications.

1. Launch LogView, and Attach LogView to your Logbook if working in an attached mode
or to a PC-Card inserted in your PC if working in a remote, unattached mode
(see previous 2 procedures if necessary).

2. Select New under the File menu or the “New” button, and give the acquisition setup file
a name relevant to your application.

3. Click the Analog Input button to display the setup grid in the Analog Input Channel
Configuration window.  Turn all but the 1st 4 channels off (or as applicable) by placing the
cursor in the On/Off column and double-clicking to toggle the setting on and off
(unused channels that are left ON will limit the maximum scan rate possible).  To change
the Range for a particular channel, click the cursor on the affected and then use the drop
down user input box to select an appropriate range (can be bipolar or unipolar).
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Selecting Input Range for Channel P1-CH02

4. Click the Digital Input button.  Turn all the digital channels “Off”—or  “On” as applicable.
5. Click the Acquisition Configuration button or select that submenu from the View pull-

down menu, and the Acquisition Configuration window will appear.
6. From the Acquisition Configuration window, select all the parameters that define your

desired acquisition.  Under the Trigger tab, select Immediate as the trigger if you want to start the
acquisition the moment the system is armed.  Under the Post Trigger tab, select a duration
of 1 minute.  In the Scan Rate frame, set Base Rate A to 5 Hz (or as applicable) by typing in a value
and selecting the proper unit.

 

Acquisition Configuration Window

 

7. After verifying that all settings are as you desire, select Save under the File menu and associate
a name to your acquisition setup file (if not already done so).

8. From the main toolbar, click the Download button to send the setup file to
LogBook’s PC-Card.

9. To arm an attached LogBook, click the Arm button.
10. To arm a remote LogBook, eject the PC-Card, transport it to LogBook, insert

it into LogBook's socket, and then apply power.
11. To upload data from an attached LogBook during an acquisition or after the acquisition is

complete, click the Upload button.
12. To upload data from a remote LogBook after the acquisition is complete or as part of card

swapping, eject the PC-Card from LogBook and transport to the PC’s socket; then click
the Upload button.

13. To inspect the data, click the View Data button.  This will activate a “view” program, if
installed.

 or 

or
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Setting Up DBK Cards
DBK cards and modules provide channel expansion and signal conditioning.  For proper
operation, you must use LogView for software configuration of the DBK cards.  All hardware
configuration-related parameters can be found in the LogBook Hardware Configuration Window
(sometimes referred to as a “hardware tree”).

Reference Note: The DBK Option Cards and Modules User’s Manual (p/n 457-0905)
contains parameter definitions and information as to which parameters are set in hardware and
which are set in software.

1. Open the LogBook Hardware Configuration Window by clicking the Hardware Configuration button.
2. To add analog input DBKs, select P1 Analog I/O in the tree, and set its property to Single-ended.

Digital DBKs use P2 port and are set up in a similar way.
3. Select a channel and assign it either a local channel or a specific DBK expansion module that will

multiplex several channels into the same main channel.  See following figure.

 
 

Setting Analog I/O Channel P1_CH00,  DBK52 T/C Card Selected

4. Most DBKs have related cards and sub-channels as part of their method to multiplex up to
16 channels into each main channel.  Click the appropriate checkboxes to set up the channels; and
then OK to accept these settings.  See following figure.

 

Selecting Applicable DBK4 Dynamic Signal Cards

5. Click the Analog Input button to view the newly setup channels in the
Analog Input Channel Configuration spreadsheet (see page 31).  Verify all channel
numbers and assign user labels as desired.

Note:   In some cases, such as with DBK19, channel values are returned in units of temperature,
instead of volts.

6. From the Analog Input Channel Configuration window, select the DBK Parameters tab to view
specific settings for each DBK channel.  Set the DBK parameters at this time.  If necessary, refer to
the appropriate section of the DBK Option Cards and Modules User’s Manual for an explanation of
the parameters; for example, DBK4 programmable filter values and DBK7 debouncing times.

You can resize the Analog Input Channel Configuration window by dragging its right edge
further to the right.  This allows you to see up to four parameters for each channel.
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Setting DBK Parameters in the Analog Input Channel Configuration Window

When configuring DBKs, the LogBook Hardware Configuration Window provides a means of setting up all
manual hardware settings.  Once configured, the analog and digital channel setup spreadsheets provide
a means of setting up channel-specific, programmable features.

Some DBKs have hardware settings that must be manually set inside the DBK, such as
jumpers or DIP switches.   In these cases the parameter setting in LogView must match
the actual hardware.  Setting one does not automatically set the other; in other words,
you must make configuration settings in both software and hardware, when applicable.

For specific DBK hardware configuration refer to the appropriate section of the
DBK Option Cards & Modules User’s Manuals (p/n 457-0905).

Using Multiple Timebases
LogBook is capable of storing channels at 4 independent timebases (one base rate and 3 rates that are
divisions of the base rate).  Two reasons for using multiple timebases are: first, to reduce the amount of
storage required by saving slow channels at a slow rate—acquisition can last longer before filling up the
PC-Card; and second, to provide noise reduction by averaging and thus enhance the value of the data.

1. Open the Acquisition Configuration window (see page pg. 43) by clicking the Acquisition
Configuration button.

2. In the scan rate frame at the right of the window, set the Base Rate A to the maximum
frequency required for any channel.

 
 

Acquisition Configuration Window
 

3. Check all three rate checkboxes B, C, D.  Type in a divider for rates B through D to create sub-rate
sampling frequencies which are based on Base Rate A.  LogView will compute and display the
corresponding rates in frequency or period units.

Note: The higher the divider (right most column) the slower the scan rate.
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4. To reduce noise in sensitive channels like thermocouples, these channels can be sampled at a high
rate but stored at a slower rate after mathematically averaging the intermediate values.  By checking
the Apply Noise Reduction Averaging checkbox, channels stored at a sub-rate will store the average
of all of the values collected at the Base Rate A.  Extraneous values that are obvious errors will have
less effect on the data—it’s also possible to set up a calculated channel that only accepts values
within a defined range.

5. Close the Acquisition Configuration Window.

6. Click the Analog Input button to display the Analog Input Channel Configuration window.  Under the
Storage tab, note that the newly configured sample rates are enabled.  The sample rate columns
determine the rate at which each channel’s data will be stored.  Each enabled (On) channel can have
data stored at sample rates A, B, C, D (or a combination, there of), see following figure.

 
 

Setting Sample Rates for Data Storage.  Each enabled channel can be assigned up to four rates.

 

7. Set the cells in these four columns to Yes or No, as desired, for all enabled (On) channels.
Channels shown as “Off” are not sampled.

8. Once configured, download the acquisition setup file, and initiate data collection.

Using Digital 2-Point Calibration
Remote LogBooks can not be calibrated.  2-point calibration can only be performed when
LogBook is attached to the PC via a communication interface.

2-point calibration allows you to mathematically “trim out” inaccuracies in the measurement equipment
and/or the transducer.  By allowing the equipment to measure 2 known points in the measurement range,
LogBook can calculate linear constants (the scale and offset) to correct inaccuracies in its analog inputs
(see page pg. 33).  For channels where only one known point can be applied and verified, LogView
provides offset trimming.

1. Click the Attach button to establish communication with LogBook.
2. Click the Analog Input button to open the analog input spreadsheet.
3. Click the 2-Point Calibration tab to expose the calibration columns.  If some columns are obscured,

scroll to the right to reveal them or resize the window by dragging the right edge further to the right.
Note that the default Cal Scale and Cal Offset [mathematically applied to each channel] are 1 and 0,
respectively (right-most columns).
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Analog Input Channel Configuration, 2-Point Cal Tab Selected

2-Point Cal Tab, Partial Close-up

4. Apply a voltage to channel 1 near the bottom end of the measurement range.
5. Type the known value into the Set P1 column for the associated channel.
6. Click the Execute button under the Get P1 heading.  This allows you to read the channel and

calculate the required offset.  Note that the channel value read is now shown in the Actual P1 column
and the Cal Offset column now shows the correction factor.

7. Apply a voltage to channel 1 near the top of the measurement range.
8. Type the known value into the Set P2 column for the associated channel.
9. Click the Execute button under the Get P2 heading to read the channel and calculate the required

offset and scale.  Note that the channel value is now shown in the Actual P2 column.  The Cal Offset
and Cal Scale columns now show the correction factors.

For channels using thermocouples, it may be impractical to provide more than one
calibration point.  In such cases, apply just one known point in Set P1, and click the
corresponding Execute button.  This will adjust the offset only, which is typically the source
of most transducer error.

For strain gages, use the User Scaling tab to enter the transducers' transfer functions (e.g.,
volts to pounds), then use 2-point calibration to periodically trim the scale and offset.  This
eliminates the need to manually adjust sensors using hardware potentiometers.
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User Scaling.   Final Reading = Scale*RawReading + Offset

An Example of Using LogView for 2-Point Calibration

Once the trimpots have been physically adjusted during initial installation, periodic trimming can be
performed through LogView’s 2-Point software calibration.  The LogView procedure does not require the
use of trimpots and should not be confused with the 2-point method in which trimpots are mechanically
calibrated as discussed in the DBK16 section of the DBK Option Cards and Modules User’s Manual.

During the LogView software procedure, 1 or 2 loads are read and compared with expected values.  The
software automatically calculates and applies the necessary correction factors.

The above figure shows the columns in the 2-Point Calibration tab.  To fine tune the accuracy of the value
coming from a linear sensor, LogView provides both 1- and 2-point calibration.

• One-point calibration can be used to zero a channel, such as a thermocouple channel, which is usually
more accurate in scale than offset.  One example of one-point calibration is that of placing a
thermocouple in an ice bath and setting the 0°C point, and no other.

• 2-point calibration determines the scale and offset factors to convert the raw readings into accurate
calibrated readings.  Two points of known (set) values must be compared with two actual sensor
readings.

An example of 2-Point Calibration (via LogView Software).

To calibrate a strain-gage scale:

1. Unload the scale.

2. Enter a value of 0.0 into the Set P1 column.

3. Click the Get P1 Execute button.  This lets you read the actual sensor value (2.0 in the
example).

4. Place a 100 lb. weight on the scale.

5. Enter a value of 100 into the Set P2 column.

6. Click the Get P2 Execute button.  This lets you read the actual sensor value (95.0 in the
example).
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LogView automatically computes the Cal Offset factor (near 0) and Cal Scale factor (near 1).

From this point on, LogView automatically applies the y = mx + b equation to the incoming reading,
resulting in a calibrated reading.

Using Digital Outputs As Alarms
Using LogView's calculated channel capability (see page pg. 37), digital outputs can be stimulated by events
such as signal levels in analog inputs (e.g., to sound an alarm at a rising temperature before a test system
over heats).

1. Click the Analog Input button to activate the Analog Input Channel Configuration
window.

2. Turn on the analog input channel that you'd like to use to stimulate a digital output
channel.

3. Click the Calculated Channel button to open the Calculated Channel Configuration
window.

4. Click the Add New Channel button (located just right of the F(x) button); or select “Add
New Channel” from the Edit pull-down menu to activate the first or next calculated channel.

5. In the Calculated Function column, type in the following equation "(P1_CH00 > 30.0) & 1". If you're
not using channel 0, replace P1_CH00 with your channel tag.  This equation will yield a 1 in its least
significant bit when the value of channel 0 is above 30, and 0 when it is below 30.

 Entering an Equation (Function Expression)

To verify accurate use of syntax, use the Equation Assistant F(x) and the Validate button
(see following figure).    The Equation Assistant is accessed via the F(x) button.  Refer to
page pg. 38 for detailed information regarding the Equation Assistant.
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The Equation Assistant can be used to create and validate equations.

6. In the Calculated Channel setup grid, set the newly configured channel to “On.”
7. Close the Calculated Channel grid.
8. Click the Output I/O Setup button.  If no digital output rows are present, click the

Hardware Configuration button in the main toolbar and add a few digital I/O ports as
outputs; e.g., the LBK2 DAC on the P3 port.

 
 

Selecting a Control Source

9. Select an output port; then set its Source to the calculated channel that we just configured.  Unless
you changed the label in the Calculated Channel grid, the source will be CALC_00.

10. Once configured, download the configuration to initiate data collection with the specified alarm
output.
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Using Exception Capturing
LogView can be set up to wait for defined events to occur, then capture data until another specified event.
The triggering process is controlled through the Acquisition Configuration window (see page pg. 43).  If
Auto Re-arm is used, LogBook will then re-arm itself after each triggering sequence, waiting for the

occurrence of the next trigger event.  This setup allows LogBook to capture specific events rather
than
a continuous data stream that may be useless in some applications.  Exception capturing is useful

where continuous data would soon fill up the PC-Card with low-value data.
1. Click the Acquisition Configuration button to open the Acquisition Configuration window.
2. Set up the trigger parameter as required.  The trigger can be set to various parameters including the

level of an analog input channel where you can select a threshold and hysteresis with rising or falling
edge.  Trigger sources include analog input level, digital channel, immediate, absolute time, and
manual Event Mark.

In the manual mode, you must select the Enable Event Mart checkbox so that the Event
Mark buttons on LogBook Monitor window and on the LBK1 are activated.

Setting Up the Trigger Parameter

3. In the Pre-trigger tab, set up a duration of time occurring before the trigger event that you would like
to save data for.  Exception capturing is most effective when you can set trigger parameters to isolate
the particular data of interest (e.g., all data 2 minutes before and after a specific event).

4. In the Post-trigger tab, you can set the stop event based on a duration, an analog or digital event, or
a manual Event Mark.

5. Enable auto Re-arm by setting the field to 10.
6. Set up input channels as needed in the Analog Input Channel Configuration window.
7. Save the setup file, download it to the PC-Card, and start the acquisition.
8. After the data has been acquired, upload the data files from the PC-Card with LogView’s Explorer or

Upload button.  Note that individual trigger blocks for each capture have indexed file names, with
each name being unique.
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Reference Note:  The File Management section of this document module, page 8, contains
detailed information regarding filename structure.

Menu Descriptions
The rest of the document module describes each menu in detail, including all the related windows and
parameters.  The menus are presented in the order they appear in the control window and can be referred to
as needed.

File Menu
New

Open

Save

Save As

Download

Upload

Download As

Configuration
Report

About LogView

Authorization

Exit

The File menu helps manage your data and configuration files.  You can determine the file format, as
well as how and where the files are saved in memory.  As stated in the previous reference note, The
File Management section of this document module, beginning on page 8, contains detailed information
regarding filename structure.

New The New command allows you to create a new file.  If you try to leave a configuration not yet saved,
dialog box asks how “Do you want to save the current configuration?”; select Yes, No, or Cancel.  The
Save/Save As window will appear.  Several icons in the top right of the window offer you help in
navigating through files and levels of folders.

Open

 

The Open command allows you open a previously created configuration file.
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Save

 

The Save command allows you to store the configuration file you are currently working on.
The Save As command uses the same window as the Save command and allows you to enter a new file
name.  The current file remains unchanged from its last save.

Save As
(no toolbar
icon)

Upload

or

The Upload command uses LogView’s Explorer to get data files from a PC-Card.  The PC-Card can
reside in LogBook if LogBook is attached to the PC or in the PC’s card slot if the PC-Card was
manually transferred from a remote LogBook.

Note:     The Upload icon and the Explorer item in the Device menu can upload from both LogBook or
the PC’s card slot; in either case, the icon looks slightly different as shown at left.

When the Upload button is clicked:
• If only 1 acquisition file (inactive) resides on the PC-Card, all that data is uploaded to the PC’s

hard drive.
• If more than 1 acquisition file resides on the PC-Card, an exploring window will appear and allow

you to select which acquisition files or trigger blocks you may wish to upload.
• (attached mode only) If the only acquisition file on the PC-Card is active, all acquired data will be

uploaded.  To prevent duplication of records and conserve storage space, data already uploaded is
then deleted from the PC-Card.
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The buttons at the bottom of the window (see following figure) allow you to:
• Upload All the files on the PC-Card to your PC’s hard drive with the designated Path and delete data

on the PC-Card if “Delete on Upload All” is selected in LogView Preferences.  Note: with attached
mode and an active acquisition, this is the only way to upload data.

• Upload Selected uploads only those files which you select.
• Delete All the files on the PC-Card.
• Refresh will refresh Explorer with data from an active acquisition.
• Cancel will close the dialog box.

If uploading an active file for the first time (using Upload All), the following window appears
(here, Cancel will stop an upload in progress):

If uploading an active file that is already partially uploaded, the following window will appear:
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Download

or

The Download command downloads the current LogView setup to LogBook if attached (or a PC-Card
if LogBook is unattached) with the same name as the LogView setup name.  If the current setup is
default-named “Untitle”, a dialog box asks “Enter the acquisition name before LogView will download
current configuration”.  Select OK to save, Cancel to stop download process.

Download
As…
(no toolbar
icon)

The Download As… command works much like
a Save As command and brings up the window
shown at left.  You can choose your own file
name.  When fields contain the correct data, select
the Download button; or you may Cancel the
operation.

The checkbox Start acquisition on “Power On” is
default-checked so that a remote LogBook will
begin an acquisition as soon as it is turned on.
You can uncheck this box if you will be using an
LBK1 to arm the acquisition or if you will be
applying power to LogBook but not wanting to
begin an acquisition immediately.

Configuration Report
Configuration Report allows you to save a report of the configuration parameters.  An example follows.

Configuration Report Window (selected from File Pull-down Menu)
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Sample Configuration Report (Condensed Image)

About LogView Provides the software version number and a statement regarding copyright violations.

Authorization The File Pull-Down menu includes an Authorization
dialog box.  If you have one or more of the
following options: Modem Support, Upload
Scheduler, or GPS Support, you must enter an
appropriate authorization code to enable the
applicable feature.  If you do not have an
authorization code you can obtain one from your
service representative, or can enable the features for
a 30-day trial period.  It is possible for a code to
authorize one, two, or three features, depending on
how the options were ordered, for example, all three
ordered during initial purchase or ordered separately
over a period of time.

Authorization Dialog Box

Exit The Exit command closes LogView.  LogView can also be closed by selecting the “X” button at
the top right of the Control Window.  If entered data has not been downloaded (saved), a dialog
box will appear with such a message.
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View Menu

Hardware Configuration

Analog Input Channels

Digital Input Channels

Output Channels

GPS/Serial Input Channels

Calculated Channels

Acquisition Configuration

Preferences

The View menu includes configuration windows, most of them in the spreadsheet format.
Descriptions of the View pull-down menu’s selections follow.

Hardware
Configuration

 

Selecting Hardware Configuration brings up the windows shown below.  As you progress through
the hardware tree, the window will prompt you for related information as needed.  All 3 I/O ports
(P1, P2, P3) are set up here.

Note: these windows only set up non-programmable parameters to match corresponding hardware
settings.  LogView cannot know these settings unless you enter them here.  Some DBKs have
programmable settings that must be set under the DBK Parameters tab of the Analog Input
Channel Configuration window.

This figure shows user
selecting the differential
mode of analog input on
P1.

This figure shows user
selecting a particular DBK
to be attached to channel
15 of P1.
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This figure shows user
selecting a particular DBK
as assigned to 1 of 4
banks of channels on P2.

This figure shows user
selecting LogBook’s timer
on P3’s Digital I/O line.

Analog Input Channel Configuration

The analog input spreadsheet (see following figure) uses four tabs to group analog input parameters.
Always visible are the Physical Channel, User Label, On/Off, real-time Reading, Range, Units, and
Channel Type columns.  Clicking a tab exposes one of the four sub-windows of parameters including
Storage, DBK Parameters, User Scaling, or 2-Point Calibration.

If beneficial, adjust column width by placing the cursor on the line between columns (in the
column header) and drag the line left or right as needed, for example, to enter a more
descriptive user label.
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In the User Label column, use the default channel labels or insert your own labels of up to 16 characters
(the column width is flexible).  Labels are saved with the data so more meaningful channel names will
appear in your post acquisition display-and-analysis software.  For example, a calculated channel that
controls an alarm can be so named; several channels that are combined for a calculated channel can be so
named, etc.

When possible, use User Label names that closely resemble the Physical Channel names.
This practice makes channel identification easier to remember and helps avoid confusion.

Example: If Physical Channel P1_CH01 was being used for an alarm, a  User Label of
P101Alarm would be logical.

In the On/Off column, use On to enable or Off to disable channels.  System performance for the enabled
channels is improved by disabling (not sampling) the channels not in use.

The Reading column displays the real-time channel value in the user’s units.  The immediate feedback by
this column allows you to optimize range settings, verify scaling, or validate sensor calibration.

For the Range column, all LogBook channels and most DBK cards have a programmable gain amplifier
(PGA) that provides multiple ranges.  Adjusting the range allows you to zoom in or out on your signal for
maximum signal resolution for the range needed.  If the Units and/or Scale (from the User Scaling tab) are
changed, the available ranges are presented in terms of the new units.  For example, if a user scaling of ×20
is applied to a channel to convert volts to PSI (pounds per square inch), the available range choices for that
LogBook channel would be ±200 PSI, ±100 PSI, ±50 PSI, 0-400 PSI, 0-200 PSI, etc.
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The next figure shows the columns accessible with the Storage tab selected (default).  If channels are
sampled only to derive calculated channels or stimulate outputs, they do not need to be stored.  For
example, a channel can be sampled at a high rate to prevent aliasing while a calculated channel is used to
derive and save its maximum every 10 seconds.  In this case, only one sample every 10 seconds is saved,
rather than thousands. The Sample Rates columns in read-only mode are set up in the Acquisition
Configuration dialog box where up to 4 timebases can be defined.  For applications with slow and fast
signals, slow signals can be sampled at a slower rate, optimizing the system’s storage capacity.  The base
rate A can be divided by 3 divisors for rates B, C, and D (see page pg. 44)

Analog Input Channel Configuration, Storage Tab Selected

Analog Input Channel Configuration, DBK Parameters Tab Selected

The above figure shows the DBK Parameters tab used to configure channels with programmable DBK
parameters.  Depending on the DBK, values must be entered in the Param.1 to Param.4 columns.  One
such example is the DBK4 that requires filter settings; some other DBK cards also have programmable
parameters.

Some DBKs have hardware switches and jumpers for configuration.  When using such
DBKs, corresponding parameters must be set in the
LogBook Hardware Configuration window.

Analog Input Channel Configuration, User Scaling Tab Selected

The User Scaling tab shown above has Scale and Offset columns.  In User Scaling, you create a transfer
function so LogView will display units that are useful for your application.  Here, you can arbitrarily define
your Units (apples, oranges, whatever) based on the raw input value, typically Volts.  To do so, type your
new unit name in the Units column and select an appropriate range (e.g. unipolar).  Then, enter its linear
scale relation to the Volt (e.g. 25 pounds per Volt) and any offset from 0 (e.g. the empty basket measures
0.1 V). The reading and range columns change accordingly.
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Analog Input Channel Configuration, 2-Point Cal Tab Selected

Calibration.  The above figure shows the columns in the 2-Point Calibration tab.  To fine tune the
accuracy of the value coming from a linear sensor, LogView provides both 1- and 2-point calibration.
One-point calibration can be used to zero a channel—as in a thermocouple, which is usually more
accurate in scale than offset.  You might place the thermocouple in an ice bath and set just the 0°C point.
2-point calibration determines the scale and offset factors to convert the raw readings into accurate
calibrated readings.  2 points of  known (set) values must be compared with 2 sensor (actual) readings.

For example, to calibrate a strain-gage scale, unload the scale, type 0.0 into the Set P1 column, then click
the Get P1 Execute button to read the actual sensor value (2.0).  Place a known 100 lb weight on the scale;
type 100 into the Set P2 column; then click the Get P2 Execute button to read the actual sensor value (95.0).
LogView automatically computes the Cal Offset factor (near 0) and Cal Scale factor (near 1).  From now
on, LogView automatically applies the y = mx + b calculation to the incoming reading to produce the
calibrated reading.
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Digital and Counter Input Channel Configuration
The basic LogBook system has three 8-bit digital ports and one high speed 16-bit port configurable as
inputs or outputs in the LogBook Hardware Configuration window (see following figure).  When
configured as inputs, these ports appear in the Digital and Counter Input Channel Configuration
spreadsheet.  Also, four pulse-input ports can count pulses for summing and/or frequency
measurement.  Adding digital expansion cards provides up to 192 digital bits.

Configuring Digital I/O Port A as Input, and with Control Resolution as Individual Bits

Digital & Counter Input Channel Configuration Screen, Channels Configured for
Individual Bits
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Digital & Counter Input Channel Configuration, Each Channel as a Port of Bits

The Physical Channel column identifies the actual hardware port of the physical channel.

In the User Label column, you can use the default channel names or type in a more suitable label up to
32 characters in length.  These labels are saved with the collected data.

The On column can enable (On) or disable (Off) individual channels.  To maximize system performance,
only channels that are enabled are sampled.

The Reading column displays the read-time value of the digital port in the format specified in the Format
column.

Analog, digital, and pulse samples are all sampled together in LogBook.  This makes time correlation
possible.  In the Acquisition Configuration dialog box, up to four timebases can be specified.  A digital or
pulse channel can be sampled at any or all of these timebases.

Channels sampled only to derive calculated channels, or to simulate outputs do not need to
be stored.

Output Channels Configuration
The Output spreadsheet shows all of the currently available digital and analog output channels.  Each
output channel requires a source channel to feed it.  Source channels can be chosen from an analog
input for an analog output for from a digital input for a digital output.

Output Channel Configuration Window
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The (physical) Channel column identifies the hardware channel assignment.
The User Label column allows you to enter a more suitable channel name of up to 32 characters.
The Source column designates the input or calculated channel used as the source of data for this output
channel.  An entry of None disables the output channels.
The Initial Value column allows you to initialize the output to a specified value.
The Units column indicates units for Initial Value.  This column can not be edited.  The default is Decimal.

Serial / GPS Channels (LogBook/360 Only)
LogBook/360 can store latitude, longitude, and altitude coordinates along with the analog and digital data
from the attached transducers, providing it is connected to a Global Positioning System (GPS) receiver.
LogView software provides an easy method for setting up the GPS channels.  No programming, character
string parsing, or protocol decoding is necessary.

LogBook/360 can provide direct support for any GPS receiver that conforms to the NMEA 0183 protocol
standard.  GPS support is not provided for LogBook/300.

GPS receivers must be purchased separately, and are available from a variety of sources.  If purchasing
a GPS make sure it conforms to the NMEA 0183 protocol standard.

LogBook Hardware Configuration

Reference Note: Refer to the GPS & Serial Device Data Collection section in chapter 5 of the LogBook
User’s Manual for detailed information.

Calculated-Channel Configuration
LogBook can derive virtual channels from real and/or virtual channels using math operators and
functions.  The resulting virtual channels can be used to:
• Create alarms based on any combination of signal levels from real channels and logical or

mathematical functions of virtual channels
• Reduce data through statistical operations, comparisons, etc.
• Develop sophisticated trigger equations using a series of averaging, comparing of other real and

virtual channels
• Manipulate input channel values for a more useful output (perhaps the quantity of interest cannot

be measured directly but depends on a complex derivation from several measurements)
• Control external devices via digital output signals (like a simple Programmable Logic Controller)
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Note: Calculated channels can have numeric values such as analog channel values.  Calculated channels
can also have digital values of 0 or 1.  These channels can be stored in any one (or all 4) timebases
set up in the Acquisition Configuration Window, in the same manner as other input channels.

User Input Box                       Equation             Add New       Cut     Paste
(Appears as needed)              Assistant            Channel

Calculated Channel Configuration Windows with Calculation Function Examples

You can access the Calculated Channel Configuration window from the control window’s View pull-down
menu, or by using the Calc (fx) button. The window contains several columns that are easy to understand
because of their labels, and their similarity to columns previously discussed.  The Calculation Function
column is a noted exception that is explained via the following four examples.

Note: Channel ID and Physical Channel nomenclature appear in the Calculation Function column.  User
Labels will not appear in the function column unless they are identical to a Channel ID, or a
Physical Channel label.

Refer to the above screen shots for the examples which follow.

In addition to understanding the equation aspect of the following examples, you should
also note the differences between the two types of configuration screens; i.e., an actual
(real) channel and the calculated (virtual) channel.

Reference Note: You may wish to refer to math or programming books to derive calculation
functions that suit your specific application.

Equation Assistant

The following window is opened by the F(x) button on the Calculated Channel Configuration window.
The Equation assistant helps to ensure that the proper syntax is used in the Calculation Function column.
Selecting the corresponding math and logic operators will enter the corresponding commands (these
commands can also be typed in, but using the equation assistant can minimize syntax mistakes).

No recursion.  A calculated channel cannot refer to itself directly or indirectly by
creating a loop of inter-related calculations.
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Equation Assistant Dialog Box

Equation Assistant Function Buttons

Arithmetic

-
(subtraction)

+
(addition)

*
(multiplication)

/

(division)

%

(modulus)
1

^

(exponentiation)

Relational and Equality

< =
(less than or

equal to)

> =
(greater than
or equal to)

<
(less than)

>

(greater than)

= =

(equal)

! =

(not equal)

Bitwise           Note: Bitwise functions are briefly discussed in the text which immediately follows this table.

&
(Bitwise And)

|
(Bitwise Or)

~
(Bitwise Not)

<<

(Shift Left)

>>

(Shift Right)

Logical            Note: Logical functions are briefly discussed in the related text which follows this table.

And Or Not
1
Note:  Modulus has several possible meanings.  As used in the equation assistant, modulus is the remainder which

results when the first operand is divided by the second.  For  example: the modulus for 3 % 3 is 0; the modulus
for 3.257 % 3 is 0.257; and the modulus for 5 % 2 is 1.0.
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Bitwise Operators

The bitwise operators perform bitwise-AND (&), bitwise-OR (|), and bitwise-Not (~) operations.

Syntax
AND-expression & equality-expression
OR-expression | Not-expression
Not-expression ~ AND-expression

The operands of bitwise operators must have integral types, but their types can be different.  These
operators perform the usual arithmetic conversions; the type of the result is the type of the operands after
conversion.

&   The bitwise-AND operator compares each bit of its first operand to the corresponding bit of its second
operand.  If both bits are 1, the corresponding result bit is set to 1.  Otherwise, the corresponding result
bit is set to 0.
Example: 10110000 & 10010000 = = 10010000

| The bitwise-OR operator compares each bit of its first operand to the corresponding bit of its second
operand.  The operator is inclusive in that, if either bit is 1, the corresponding result bit is set to 1.
Otherwise, the corresponding result bit is set to 0.

Example: 10110000  | 10010000 = = 10110000

~ The bitwise-NOT operator creates a bitwise compliment of its operand.  Thus, a 0 switches to 1, and a
1 switches to 0.

Example: ~ 10110000 = = 01001111

Bitwise Left Shift and Right Shift Operators:   <<, >>

Syntax:
shift-expression << additive-expression
shift-expression >> additive-expression

The bitwise shift operators shift their first operand left (<<) or right (>>) by the number of positions the
second operand specifies.

Example:  10110000 << 2 = = 11000000

Logical Operators

The logical operators perform logical AND, logical OR, and logical NOT operations.

Logical operators do not perform usual arithmetic conversions.  Instead, they evaluate each operand in
terms of its equivalence to 0.  Thus, the result of a logical operation is either 0 or 1.

AND The logical-AND operator produces the value 1 if both operands have nonzero values.  If either
operand is equal to 0, the result is 0.  If the first operand of a logical-AND operation is equal to 0,
the second operand is not evaluated.

OR The logical-OR operator performs an inclusive-OR operation on its operands.  The result is 0 if both
operands have 0 values.  If either operand has a nonzero value, the result is 1.  If the first operand of
a logical-OR operation has a nonzero value, the second operand is not evaluated.

The operands of logical-AND and logical-OR expressions are evaluated from left to right.  If the
value of the first operand is sufficient to determine the result of the operation, the second operand is
not evaluated.  This is called "short-circuit evaluation."

NOT The logical-negation (logical-NOT) operator produces the value 0 if its operand is true (nonzero)
and the value 1 if its operand is false (0).  The operand must be an integral, floating, or pointer
value.
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Examples of Calculated Channels

Example 1:   P1_CH14 > 23

In this example the user wants to use CALC_00 as a logic indicator based on the state of physical channel
P1_CH14; thus channel CALC_00 will read 1 or 0, depending on the value of the physical channel’s
reading.

The user created a calculation function: P1_CH14 > 23.  The calculation channel is labeled CALC_00 as
seen in the following figure.

Assume P1_CH14 had a reading of 26.13.  Since 26.13 is greater than the value 23 in the calculation
function, CALC_00’s reading would appear as 1.0.  If the channel P1_CH14 reading drops to 23 or lower,
CALC_00 will read 0.0.  Note that CALC_00 can be used in additional equations as will be seen in
example 2.

To obtain a calculation channel, select the Calculated Channel Configuration window’s Edit pull-down
menu, then select Add Channel.  In regard to the calculation function column, the following steps highlight
how to enter the function used in this first example, i.e.,  P1_CH14>23.

1. Ensure the physical channel to be referenced is enabled.  In this case: P1_CH14.
2. Use the Calc (y = fx) button in the toolbar or Calculated Channels from the View pull-down menu to

access the Calculated Channel Configuration Window.
3. Select the Edit pull-down menu (located on the Calculated Channel Configuration window).
4. Select Add New to add a calculation channel.  In our first example this is CALC_00.
5. Click on the cell in the Calculation Function Column.

A  F(x)  button appears by the Enter Function Expression dialog box.
6. Use the F(x)  button to access the Equation Assistance dialog box.
7. In the Equation Assistant box, double-click on the desired reference channel.  P1_CH14.  This entry

will appear in the equation box, located just below the title bar.  Note that you may type the channel,
and other equation entries in this box, if desired.

8. From the Relational and Equality buttons (<=, >=, <, >, = =, !=) select the “greater than” symbol (>).
This entry will appear in the equation box.

Equation Assistant Dialog Box

9. With the cursor placed after the greater than symbol, type 23.
10. Verify that your function appears correctly and click the Validate button.  Validate will verify that

you have a useable equation and will inform you when there is a problem with an equation.  For
example, you may have a missing parenthesis.

11. If necessary, correct your equation and validate the new one.

12. Click the OK button.  This closes the Equation Assistant.
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Though the previous ten steps pertain to the first example, aside from functional differences, the method is
essentially the same for the remaining three examples.  A figure and table have been placed after the
examples to identify various button options available with the Equation Assistant.

Example 2:   CALC_00 And(P1_CH15>24)

Look at row 2 in the Calculated Channel Configuration screen above.  You will see that the user created a
calculation function of CALC_00 And(P1_CH15 > 24) for the calculation channel having the channel ID
of CALC_01.  In this example the user wants to use CALC_01 as a logic indicator based on the state of
both CALC_00 and physical channel P1_CH15.

In this example, channel CALC_01 will read 1 if both of the following are true:
a)  CALC_00 has a value of 1.0
b)  P1_CH15 has a value greater than 24

Assume that P1_CH14 had a channel reading of 23.09 and that P1_CH15 had a value of 21.81.  In this case,
CALC_00 will have a value of 1.0 because P1_CH14 is greater than 23.  P1_CH14>23 was set in
example 1.

In our example 2 function of CALC_00 And(P1_CH15>24) it is clear that although the first condition is
satisfied, we can see that the second is not, since P1_CH15 has a reading of 21.81.  Because both conditions
are not satisfied, CALC_01 reads 0.0.  Note that CALC_01 can be used in additional equations.

Example 3:  P1_CH14+P1_CH15

Look at row 3 in the Calculated Channel Configuration screen (previous figure).  You will see that the user
created a calculation function of P1_CH14+P1_CH15 for the calculation channel having the channel ID of
CALC_02.  In this example the user wants to use CALC_02 to indicate to sum of two physical channels,
i.e., P1_CH14 and P1_CH15.

In this example, assume that:
a)  P1_CH14 reads 25 volts, and
b)  P1_CH15 reads 24 volts

In this case CALC_02 will be the sum, 49 volts.

Note that CALC_02 can be used in additional equations.

Example 4:  P1_CH14*2

Look at row 4 in the Calculated Channel Configuration screen (previous figure).  You will see that the user
created a simple calculation function of P1_CH14*2 for calculation channel CALC_03.  In this example
the user wants CALC_03 to read twice the value of physical channel P1_CH14.

Note that CALC_03 can be used in additional equations.
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Acquisition Configuration
The Acquisition Configuration dialog box allows you to define trigger conditions including various
parameters for pre-trigger, trigger, post-trigger, scan rate and timebase.
LogBook data can be collected in two basic ways depending on the trigger setup:

• Continuous.  As a simple data logger in a strip chart mode, all data collected is then saved.  The
trigger source can be set to immediate and the post-trigger scan count set to infinite.

• Exception-only.  As an exception-capturing system, collected data is saved only under specified
conditions.  Pre-trigger, post-trigger, and re-arm parameters allow you to collect only data around
specified events, just the data of interest, nothing more.  Thus memory is conserved, and post-analysis
is easier.

The next figure shows a time line with data being collected continuously, but only the trigger block is
logged to memory (the pre-trigger and post-trigger data combined is called a trigger block).

Trigger Parameters Setup

The following figures represent Trigger Setups with and Analog Channel as a trigger source
(channel P1_CH14) and a Calculated Channel as a trigger source (CALC_00).
Other possible trigger sources are:
When Armed, Manual, Digital Channel, GPS Channel (LogBook/360 only), and Absolute Time.

Trigger Setup Using an Analog Channel            Trigger Setup Using a Calculated Channel

The manual trigger can be implemented in the following ways:
• With a PC attached, you can trigger LogBook from LogView’s LogBook Monitor window in the

Device menu.
• Without a PC, you can use the Remote LogBook Terminal (LBK1) manual trigger button.

The auto re-arm feature allows for a large number of acquisitions to take place automatically, with each
acquisition using the same settings.  As soon as the previous trigger block is terminated, the system
immediately re-arms itself, waiting for the trigger condition to be satisfied.  The Number of Re-arms field
allows you to specify how many triggered acquisitions to capture.  For exception-capturing, specify the
number of trigger blocks that should be collected before data logging is terminated.  For continuous data
logging, specify 1 trigger block.
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If Absolute Time is selected for the trigger source, the
window changes as shown in the figure at right.  The
parameters include the date and time as well as options
for re-triggering after a specified duration.

A wide variety of trigger sources and stop events provide
great flexibility in exception-capturing.  If data collection
is desired only under specific conditions, appropriate
trigger conditions can be so specified.  Besides the trigger
event, you can define a pre-trigger and post-trigger for the
trigger block.  An example of exception-capturing would
be to collect 100 pre-trigger scans and 1000 post-trigger
scans every time a designated channel read a specified
temperature.

Using Absolute Time as a Trigger Source

To conserve memory when collecting high-speed data, use the trigger to take snapshots of
information only during the appropriate periods.

When using a trigger to start the acquisition, a pre-trigger count can be supplied so that information just
before the trigger can be collected and saved (LogBook’s buffer allows pre-trigger data to be stored
temporarily until saved in a trigger block).  The post-trigger definition specifies when the data collection
activity should end.

            
Pre-Trigger Setup Post-Trigger Setup

You can also use a calculated channel as a trigger source, but you must use an analog output or digital
channel as an intermediary.  The calculated channel can be based on real channels and user logic to create
an analog output channel or a digital output channel that could then be the input for the trigger event or stop
event.  A calculated channel can describe virtually any combination of channel conditions.  For example,
you can develop a calculated channel called TRIG and specify it as the trigger channel.  If the channel’s
equation is TRIG = (Temp1-Temp2)>50.0°, the data collection process will be triggered when the
difference between the 2 channels is greater than 50.0°.

Scan Rate Setup

Scan Rate Setup.  Accomplished on the right-half of the Acquisition Configuration Window.
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The Scan Rate block is the right half of the Acquisition Configuration window (see previous figure).
To set the scan rate, you can use LogBook’s “internal” clock, or an “external” clock.  Brief descriptions
follow.

Note: The scan-to-scan time is not recorded when tracking variable-speed events.

• Internal Clock.  The scan-to-scan timing may be set by a fixed-frequency pacer clock.
LogBook’s time-of-day clock has 1/16-second resolution for data-logging applications where
acquisitions must be performed at specific times during the day.  The time of occurrence for each
acquisition and its trigger are recorded with the data.  The internal clock can be reset in the
LogBook Monitor window in the Device menu.

• External Clock.  Each scan may be individually started by an external TTL level trigger to
allow the scan rate to track an external, variable-speed event (such as engine revolutions).  The
external clock signal is applied to LogBook through pin 20 of the P1 DB37 Analog I/O connector.
The P1 pinout is included in chapter 4 of the LogBook User’s Manual.

Question:  Why is the Pin 20 [for the external clock] identified as PCRCLK output/input?
Answer:   When LogBook is set for an external user-supplied pacer, pin 20 has an input function.
When LogBook is set to make use of its internal FPGA (Frequency Pulse Gain Amplifier) supplied
pacer, pin 20 is driven as an output.  This allows instrumentation external to LogBook to be
triggered in sync with LogBook scans.

Question:  On what edge is the sample taken?  Rising or Falling?
Answer:   Rising edge, low-to-high direction, where the minimum pulse high-time equals the low
time (100nsec).

For applications with both slow and fast phenomena, sampling slow signals at a slower rate while
maintaining high rates for fast signals will conserve memory.  For example, channel 1 may read fast signals
like vibration and can be sampled at the high (base) rate; channel 2 may read slow signals like
thermocouples and can be sampled at a lower rate.  A Base Rate A and up to 3 more rates (B, C, D) can be
configured; but only one base rate can be defined for the entire system and it should be set for the fastest
scan required.  The B, C, D rates must be integer (whole number) divisions of the base rate.  It is also
possible to scan the same channel at several rates.

Note: A separately indexed data file is created for each scan rate.

The checkbox “Apply noise reduction averaging” refers to auto-averaging for scan rates B, C, and D.
All channels are scanned at the base rate; but they may also be scanned at divisions of the base rate.  Two
advantages to averaging are noise reduction by limiting the effect of extraneous readings and storage
savings since fewer values are stored.

• Averaging.  Checking this box, the readings from the base rate will be averaged, and the average
value will be entered for the derived rate scan.  If the scan rate B is ¼ of the base rate A,
then four A readings will be averaged for each B reading.

• No averaging.  Not checking this box, the readings at the derived scan rates will be exactly the same
for that time-point as the base rate.

Event Marking/Time Stamping

The top right side of the Acquisition Configuration window allows you to manually mark events and/or
insert an absolute time reference for each scan:

• Enable Event Mark sets up the acquisition for an operator to press the Event Mark button in the
LogBook Monitor window or on the LBK1 remote operation terminal.  Whenever the button is
pressed, that data point is added to the data file.

• Enable Time Stamp sets up the acquisition to automatically add the time (to ms) and date to the data
file for every scan.



pg.  46 05-07-02 LogView

Preferences
(no toolbar
icon)

LogView allows you to set various
parameters to make your application
more useful and convenient.  These
preference settings are divided into
4 tabs as shown in the figures on the
right.

Most of the options cover default use of
filenames and validating changes to
files.

LogView Preferences, General Tab Selected

LogView Preferences, Download Tab Selected

As explained in the File Management
section (see page pg. 9), LogView can
generate multiple data files for an
acquisition and then automatically
name them.  These names have a long
format with several fields (seed, serial
number, date armed, time armed,
trigger block/segment).  Unless you
need the long-format name to prevent
file overwrites, you can uncheck the
fields you don’t need.  For example, if
only using one LogBook, the serial
number is not needed.

LogView Preferences, Upload Tab Selected



LogView 05-07-02 pg. 47

For data conversion:
1) Select the LogView Preferences “General Tab.”
2) Click on the “File Converter” button.  The File Converter Preferences dialog box appears.
3) Select the formats you want to save your data in.
4) If desired, check to automatically delete the source data file after conversion.  The default avoids

automatic deletion of the source data file.
5) Select the overwriting-related preference you desire.  The default is to “Validate overwriting of each

existing file.”

File Converter Preferences Dialog Box
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Device Menu
Select PC Card

Select LogBook

Attach

Break

Arm Acquisition

Stop Acquisition

LogBook Monitor

Explorer

The Device menu allows you to choose devices in your system, attach or break connection to the
system, and to start and stop an acquisition.

Select
PC-Card
(no toolbar icon)

Select PC-Card allows you to choose which drive
on your computer you wish to make active for
uploading and downloading—especially relevant if
your computer has more than one PC-Card slot.

Select PC-Card

Select
LogBook
(no toolbar icon)

Select LogBook allows you to choose devices from
your system and then verify or change the
communication port settings.

Select LogBook

Attach allows you to establish connection with a LogBook.  If no LogBook is connected, LogView will
automatically attach to a PC-Card in the user-specified PC-Card drive
(specified in the “Select PC-Card” dialog box).

Break allows you to break the connection with an attached LogBook.

Arm Acquisition Arms the acquisition for the selected device.  The scan will begin when the selected
trigger condition is met.

Stop Acquisition will disarm the acquisition for the selected device.  No data will be collected despite
trigger conditions until the acquisition is armed (started).
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LogBook Monitor
(no toolbar
icon)

The LogBook Monitor provides a system status report on the current acquisition (if in progress).  The
window allows provides access to manual-trigger and chart-marking functions.  You can access LogBook’s
Explorer by clicking the button in the lower right-hand corner of the screen.  The Explorer allows you to
search the PC-Card for acquisition files and the indexed trigger blocks within the acquisition files (see
following section for more Explorer information).

LogBook Monitor

The acquisition status is only updated every 1 or 2 seconds; the status for scans at a faster rate may not be
updated before the scan is finished.

Whenever you select the Event Mark button during an acquisition, LogView notes the exact time to time-
correlate the marked instant with data collected then.  This function is like marking a strip chart to draw
attention to a particular time frame.  These marks can be seen later while reviewing the data in an
independent view application.

The Enable Event Mark (in the Acquisition Configuration window) must be checked in order
for the LogBook Monitor to be enabled.  This event-marking feature is also accessible via
LBK1.

Max Swap Time (Maximum Disk Swap Time) is the estimated amount of time that the user
has to remove and replace LogBook’s PCMCIA card without interruption to LogBook’s
active acquisition.

The Manual Trigger button is available here and will activate the trigger or post-trigger event immediately
when selected (also accessible via the LBK1).

Under LogBook Settings, you can read the current time of LogBook’s clock.  You can reset LogBook’s
clock to the PC’s clock by selecting the Reset Clock button.

The Error box contains an error number and brief description of the error.  These error codes are provided
near the end of this manual.  Not all errors are fatal to the acquisition.
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Explorer
(no toolbar
icon)

The Explorer window can be reached from the Device menu or from its button in the LogBook Monitor
window.  Explorer allows you to search the PC-Card for acquisition files and the indexed trigger blocks
within the acquisition files.  The Exploring windows look first at the acquisitions saved to disk and then
deeper into each trigger block within an acquisition.

The convention for naming files is described on page pg. 9.  In the following example (see figure below),
TriggerBlock_2-2 uses “TriggerBlock” as the seed and “2-2” to indicate the 2nd segment of the 2nd trigger
block.  The binary data file ends with the .bin extension understood in the LogView Explorer.

LogBook Explorer Window, Two Examples
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Tools Menu
Convert Binary

Data

Merge Binary Data

View Data

The Tools menu provides three selections:
• Convert Binary Data - allows you to convert raw binary data (*.bin files) into other formats

that you may find more useful.
• Merge Binary Data – allows you to merge Rate files and to concatenate Trigger Block

segments.
• View Data – Accesses the independent view program for graphing and analysis of previously

recorded data.

Convert
Binary Data
(no toolbar
icon)

The Convert Binary Data menu option allows you to convert raw binary data (*.bin files) into other
formats that you may find more useful.  You must first select an existing binary file to be converted.
The filename can be typed in or selected by the Browse button that leads to a folder/file search
window. After a file is selected (or multiple files), you can toggle check-boxes on/off for each format
type.  When ready to begin the conversion, select the Convert button and set up the destination
folder/filename.

Data collected with LogBook can be uploaded to your PC’s hard disk in any or all of several data
formats for post-acquisition analysis.  Some of the available file formats include Snap Master,
DADiSP, Matlab, and ASCII (Excel) which is compatible with most software for analysis.  LogView
creates the necessary header files for each data format so that the software can use the channel labels,
the timebase information, and other parameters.

Converted data files are placed in format-specific subdirectories of the binary source file directory.

Rates, Trigger Blocks, and Segments

LogBook has the capacity to save channel data at four independent rates.  For each enabled rate, a file is
created. For example, if all four rates are being used, four files will be present after an upload.  Depending
on the Upload Preference settings (as discussed in Preferences, page pg. 46), the file names will look
similar to the following.

TEST R1 B1-1.BIN “TEST” is the name of the acquisition configuration.
TEST R2 B1-1.BIN “Rn” shows the rate number.  R1 through R4 is Rate1 through Rate 4.
TEST R3 B1-1.BIN
TEST R4 B1-1.BIN

“Bn-m” shows the trigger block and segment numbers.
For example, B1-1 indicates “Block1, Segment 1.”

Note:  Files with high rates take up more memory than files with slow rates.

Auto Re-arm is used when multiple trigger events need to be captured. When the auto re-arm feature is
enabled, LogBook will arm itself, wait for a trigger, collect the pre- and post-trigger, then re-arm itself and
repeat the process.

The pre- and post-trigger data surrounding a trigger point is called a Trigger Block.  A new file is
created for each Trigger Block.  If only one rate is used and three Trigger Blocks are collected, the file
names would look similar to the following.

TEST R1 B1-1.BIN
TEST R1 B2-1.BIN
TEST R1 B3-1.BIN

In each case, R1 indicates Rate 1.  B1, B2, and B3 indicate Trigger
Blocks 1, 2, and 3, respectively.  The “-1”, in each case, indicates
Segment 1.

Uploads can be performed while data is being collected. For applications that require continuous
acquisition, uploads can be performed periodically to make space for additional data. Each uploaded
portion of a single Trigger Block is called a Segment.  If one rate is used and a Trigger Block was
uploaded in five Segments, the file names would look similar to the following.

TEST R1 B1-1.BIN
TEST R1 B1-2.BIN
TEST R1 B1-3.BIN
TEST R1 B1-4.BIN
TEST R1 B1-5.BIN

In each case, R1 indicates Rate 1.  B1 indicates Trigger Block 1, and
“-1” through “-5” indicates Segment 1 through Segment 5.
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Merging and Concatenating

LogView’s raw binary format can not be used by other programs; however, LogView can convert its data files into
popular file formats used by other display and analysis packages.  The conversion can be performed automatically
during an upload, or manually after the upload using the Convert Binary Data utility (found under the Tools pull-
down menu).
In addition to providing for file format conversion, the Convert Binary Data utility also has the ability to merge
Rate files and to concatenate Trigger Block segments.  Examples follow shortly.

• When merging Rate files, the utility takes the appropriate rate files and combines them into one file.
• When concatenating segments, the utility joins the appropriate segment files, making one continuous

Trigger Block file.
• When both Merge and Concatenate are enabled, Trigger blocks with multiple rates (that were uploaded in

segments) can all be consolidated into one file.

The Convert Binary Data utility lists all the raw binary files in the DATA directory.  Select the desired file(s) and
click Convert to initiate the process.  In this way, any Trigger Block, Segment, or Rate file can be individually
converted.

Sample Screen from the Convert Binary Data Utility



LogView 05-07-02 pg. 53

Merging Binary Data
(no toolbar icon)

Preparing to Merge Subrates

A screen similar to that shown in the above figure appears when the “Merge Binary Data” is selected from the Tools
pull-down menu.  On this window, when the Merge Subrates box is checked, the Convert Binary Data utility groups
the related Rate files together and displays a single item.  In the example below this single item is:
TEST R* B1-1.BIN.

The number of files that this item describes is now shown in size column of the list box (4 files).  Selecting
TEST R* B1-1.BIN and then clicking the Execute button (lower right) will convert and merge the files.

TEST R1 B1-1.BIN  --------  TEST R* B1-1.BIN
TEST R2 B1-1.BIN     |
TEST R3 B1-1.BIN     |
TEST R4 B1-1.BIN __|

Concatenating (Linking) Segments
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File Convert Utility Screen Shown Both Before and After Selecting “Concatenate Segments”

When the Concatenate Segments box is checked, the File Convert utility groups the Segment files together and
displays a single item.  In the example, the single item is TEST R1 B1-*.BIN.  The number of files that this item
describes is now shown in size column of the list box (5 files). Selecting TEST R1 B1-*.BIN and then clicking the
Execute button (lower right of utility) will both convert and concatenate the files.

TEST R1 B1-1.BIN  --------  TEST R1 B1-*.BIN
TEST R1 B1-2.BIN     |
TEST R1 B1-3.BIN     |
TEST R1 B1-4.BIN     |
TEST R1 B1-5.BIN __|

Note:  For applications that require continuous data collection, the Upload Scheduler can periodically upload the
data to a local PC, creating new space on the LogBook’s PC-Card.  The Upload Scheduler is discussed in the
LBK Options chapter of the LogBook User’s Manual.

View Data
The View Data button launches an independent post-data acquisition view program, if installed.
Examples of view programs are DIAdem and the eZ-Analyst set of view applications.  The Post
Acquisition Data Analysis User’s Guide PDF documents the applicable application(s).  The PDF
document is automatically installed onto your computer’s hard-drive as a part of LogBook product
support at the time of software installation.
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Indicators Menu

Bar Graph Meters

Analog Meters

Digital Meters

Enable Input Reading Column

Start All Indicators

Stop All Indicators

Along with displaying channel data in real time in the setup spreadsheets, LogView also
provides auxiliary real-time indicators.

The meter windows simulate the look of popular meter types: the bar graph, the analog
dial, and the digital readout.  Within each meter type, you can adjust their display
properties to fit your needs.  Such properties include number of channels, high/low limits,
peak hold, trend indicator, etc.
Next, each meter type is shown; and then, their configuration is discussed (they all work
in a similar way).

Bar Graph
Meters
(no toolbar
icon)

Selecting the Bar Graph Meter icon
brings up the Bar Graph window to
display several channels in bar graph
format.  To activate the display, select
the Start button on the left side of the
toolbar (or Start All Indicators in the
pull-down menu or in the toolbar).  You
can vary the number of channels
 (32 max) displayed by selecting the
input box at the end of the toolbar.  The
Grid button (next to last item on toolbar)
is used to arrange the display for
convenient reading.  The pushpin icon in
the center of the toolbar locks this
window on top of other windows until
you unlock it by selecting the pushpin
again.

Analog
Meters
(no toolbar
icon)

Selecting the Analog Meter icon brings
up the Analog Meters window to display
several channels in a dial/gage format.
To activate the display, select the Start
button on the left side of the toolbar (or
Start All Indicators in the pull-down
menu or in the toolbar).  You can vary
the number of channels (32 max)
displayed by selecting the input box at
the end of the toolbar.  The Grid button
(next to last item on toolbar) is used to
arrange the display for convenient
reading.  The pushpin icon in the center
of the toolbar locks this window on top
of other windows until you unlock it by
selecting the pushpin again.
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Digital
Meters
(no toolbar
icon)

Selecting the Digital Meters icon brings
up the Digital Meters window to display
several channels in numeric format.  To
activate the display, select the Start button
on the left side of the toolbar (or Start All
Indicators in the pull-down menu or in the
toolbar).  You can vary the number of
channels (32 max) displayed by selecting
the input box at the end of the toolbar.
The Grid button (next to last item on
toolbar) is used to arrange the display for
convenient reading.  The pushpin icon in
the center of the toolbar locks this
window on top of other windows until
you unlock it by selecting the pushpin
again.

Meters Configuration
The toolbars and pull-down menus for the three meter
types are identical except that Digital Meters does not
have a Reset Peak Hold icon.

Meters Toolbar Icons
Item Name Function

Start Starts meters.

Stop Stops meters.

Reset Peak Hold
Indicator

Resets the floating markers.  Upon reset, the markers will instantly adjust to
indicate the highest and lowest values reached since the time of the reset.

This feature does not apply to the Digital Meters.
Stay On Top
(Push pin)

Locks or unlocks the meter window on top of other windows.

Print Sends the meter(s) display image to connected printer.

Rows x Columns Opens a small menu with “row x column” arrangement options.  Example: When
the number of meters is 6 the grid options will be: 6x1, 3x2,  2x3, and 2x4 with
the first number being the number of rows.  If you then select 3x2 you will have
3 rows of meters with 2 meters per row.

Number of Meters Specifies the number of meters to appear on the screen.
Up to 32 meters can be selected.

The meters windows each have a Control and View pull-down menu, as indicated by the following figure.
These menu items correspond to the toolbar icons described above.
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A meters configuration menu (lower left corner of figure) will appear when you place the mouse pointer
over a meter and click the right mouse button.  This menu allows you to access various dialog boxes for
changing parameters for meters.  The steps for configuring a meter are detailed below.

Note:  The Show Peak Hold Indicator / Reset Peak Hold Indicator selections are not an option for Digital
Meters and do not appear on the configuration window for digital meters.

Meter Configuration Menu and Related Dialog Boxes

Configuring a Meter

1. Bring up the desired meter group (Bar Graph, Analog, or Digital).
2. Place the mouse cursor over the meter to reconfigure.
3. Click on the right mouse button.  A Meters Configuration Menu will appear (see figure above).
4. Select the desired option from the meter configuration menu.
5. If a dialog box is required, for example, to change a limit, enter in the new value in the appropriate

parameter box and press “Apply” or “OK.”  Pressing “Apply” implements your changes, but keeps
the dialog box open, allowing you to make additional changes.  Pressing “OK” implements your
changes and closes the dialog box.

The previous figure and the next table and the previous figure serve as a quick reference to meters
configuration.
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Configure Meter Settings, Function Descriptions
Function Description
Select Channel Select a new channel for display.  The selected channel will replace the one

currently seen in the meter.  Note that double-clicking the left mouse button in the
meter region will also bring up a dialog box which allows you to select a new
channel.

Set Scale Set the high and low points of the scale as well as define the decimal place format.
Show Peak Hold

Indicator
Places high and low uni-directional floating markers on the scale to indicate the

highest and lowest values reached up to the present time.  This feature does not
apply to the Digital Meters selection.

Reset Peak Hold
Indicator

Resets the floating markers.  Upon reset, the markers will instantly adjust to indicate
the highest and lowest values reached since the time of the reset. This feature
does not apply to the Digital Meters selection.

Show Trend
Indicator

Displays a pointer to indicate the direction of the trend.  Note that during rapid meter
fluctuations the increase and decrease pointers will appear to blink
simultaneously.

Set Limits Provides a way of establishing high and low limit set-points.
Show Limits Displays limits by adding color (red for high, blue for low) to the scale regions which

equal and exceed the set limit values.  For Digital Meters the limits are indicated
by red numbers and an upper red bar for hitting or exceeding the high limit; and
blue numbers and a lower blue bar when reaching or exceeding the low limit.

Properties Allows setting and showing limits, as well as opening the Scale dialog box.

You can access a different dialog box from the one initially selected.  For example, from the Set Scale
dialog box you can select Limits to access the Set Limits/Show Limits display, as well as select “Misc.”
which allows you to “Show Trend Indicator” and “Show Peak Hold Indicators.”

Mouse buttons
• Left: Double-clicking the left mouse button in a meters scale area brings up a channel selection pop-up

menu.
• Right: Single-clicking the right mouse button in a meters scale area brings up a configuration pop-up

menu.

Enable Input Reading Column
(no toolbar
icon)

This command enables/disables the “Reading” column of the Analog Input Channel Configuration
spreadsheet to provide a numeric view of incoming data.  This function toggles on and off when the
menu item is repeatedly selected.

Note:    With the input reading columns ON, no modifications to program parameters may be
performed.

Start (or Stop) All Indicators
(no toolbar
icon)

Starting or Stopping all indicators affects several windows if open, including: Reading column, Charts,
Bar Graph Meters, Analog Meters, and Digital Meters.  Note: you can start or stop any of these active
windows separately using their own Start or Stop (Pause) buttons.
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Error Codes

Software Errors
These errors can appear in the LogBook Monitor window of LogView.

0 No Error 240 Invalid Version
Command Error Definitions 241 Hardware Error

100 Command Error 250 Hardware Missing
101 Invalid Character 251 Mass Storage Error
102 Syntax Error 252 Missing Media
103 Invalid Separator 253 Corrupt Media
104 Data Type Error 254 Media Full
105 GET Not Allowed 255 Directory Full
108 Parameter Not Allowed 256 File Name Not Found
109 Missing Parameter 257 File Name Error
110 Command Header Error 258 Media Protected
111 Header Separator Error 260 Expression Error
112 Program Mnemonic Too Long 261 MathError In Expression
113 Undefined Header 270 Macro Error
114 Header Suffix Out Of Range 271 Macro Syntax Error
120 Numeric Data Error 272 Macro Execution Error
121 Invalid Character In Number 273 Illegal Macro Label
122 Mantissa Too Large 274 Macro Parameter Error

Not Defined In SCPI 275 Macro Definition Too Long
123 Exponent Too Large 276 Macro Recursion Error
124 Too Many Digits 277 Macro Redefinition Not Allowed
128 Numeric Data Not Allowed 278 Macro Header Not Found
130 Suffix Error 280 Program Error
131 Invalid Suffix 281 Cannot Create Program
134 Suffix Too Long 282 Illegal Program Name
138 Suffix Not Allowed 283 Illegal Variable Name
140 Character Data Error 284 Program Currently Running
141 Invalid Character Data 285 Program Syntax Error
144 Character Data Too Long 286 Program Runtime Error
148 Character Data Not Allowed 290 Memory Use Error
150 String Data Error 291 Out Of Memory
151 Invalid String Data 292 Referenced Name Does Not Exist
154 String Data Too Long 293 Referenced Name Already Exists
158 String Data Not Allowed 294 Incompatible Type
160 Block Data Error Device-Specific Error Definitions
161 Invalid Block Data 300 Device Specific Error
168 Block Data Not Allowed 310 System Error
170 Expression Command Error 311 Memory Error
171 Invalid Expression 312 PUD Memory Lost
178 Expression Data Not Allowed 313 Calibration Memory Lost
180 Macro Definition Error 314 Save Recall Memory Lost
183 Invalid Inside Macro Definition 315 Configuration Memory Lost
184 Macro Parameter Command Error 320 Storage Fault

Execution Error Definitions 321 Device Out Of Memory
200 Execution Error 330 Self Test Failed
201 Invalid While In Local 340 Calibration Failed
202 Settings Lost Due To RTL 350 Queue Overflow
203 Command Protected 360 Communication Error
210 Trig Error 361 Parity Error In Program Message
211 Trig Ignored 362 Framing Error In Program Message
212 Arm Ignored 363 Input Buffer Overrun
213 Init Ignored Query Error Definitions
214 Trig Deadlock 400 Query Error
215 Arm Deadlock 410 Query Interrupted
220 Parameter Error 420 Query Unterminated
221 Settings Conflict 430 Query Deadlocked
222 Data Out Of Range 440 Query Unterm After Indef Response
223 Too Much Data Power On Event Definitions
224 Illegal Parameter Value 500 Lbk Event Power On
225 Operation Out Of Memory 600 Lbk Event User Request
230 Lists Not Same Length 700 Lbk Event Request Control
231 Data Corrupt Or Stale 800 Lbk Event Operation Complete
232 Data Questionable 900 Outputs Deteriorating
233 Invalid Format 905 Losing Trigger Events

906 Losing Stop Events
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Hardware Errors
The following is a list of fatal hardware errors.  LogBook’s ERROR LED indicator (on the front panel) will
blink on/off the number of times indicated by the flash code.  If the LogBook is attached to an LBK1, the
corresponding control terminal message will be displayed (otherwise, you must count the LED flashes to
determine the error).  Note that flash codes 08, 09, and 17 are associated with multiple errors and thus
require an LBK1 to determine which error applies.

ERROR LED

Flash Code Control Terminal Message

1 NS486 Chip Revision Changed Error

2 Watchdog Timeout Error

3 Flash Startup Code Checksum Error

4 Flash FPGA Code Checksum Error

5 DRAM initialization not complete Error

6 DRAM Sizing Error

7 1 MB DRAM SIMM - Insufficient Memory

8 DRAM Address Line Error

8 DRAM Data Line Error

8 DRAM Integrity Test Error

9 SRAM Address Line Error

9 SRAM Data Line Error

9 SRAM Integrity Test Error

10 SRAM Low Battery Error

11 FPGA Load Error

12 Real Time Clock Low Battery Error

13 DRAM Parity Error

14 Analog Output Slot Empty

15 Calibration Table Verification Error

16 ADC Self Calibration Error

17 TRAP: Divide by Zero, or Divide Overflow

17 TRAP: Debug Trap; Hardware Breakpoint

17 TRAP: Non-Maskable Interrupt (NMI)

17 TRAP: Software Breakpoint

17 TRAP: INT0 Instruct.: Overflow Detected

17 TRAP: BOUND instruction: Range Exceeded

17 TRAP: Invalid Opcode

17 TRAP: Coprocessor Not Available

17 TRAP: Double Fault

17 TRAP: Coprocessor Segment Overrun

17 TRAP: Invalid Task State Segment

17 TRAP: Segment Not Present

17 TRAP: Stack Exception

17 TRAP: General Protection Fault

18 Printf Floating Point Error

19 FPGA PC-Card File Checksum Error

20 FPGA PC-Card File Load Error

    DRAM = Dynamic Random Access Memory (the 4- or 16-MB SIMM board)
    SRAM = Static Random Access Memory
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